
 



Index
For help using Help, press the F1 key.

The following Help Topics are available:

Getting Started

Command Index

What is The Sign Maker for?

How do I register?



Getting Started with The Sign Maker
Opening a sign file. 

Choosing a Template. 

Changing the Font and Size 

Printing a sign 

Saving a sign 

The Sign Maker's Help features 



Template
The Sign Maker uses templates, or guidelines to aide you in creating high quality, low cost signs for 
your store.    These guidelines are meant to show you where the boundaries of your selected sign 
dimensions are.



Opening a Sign File
To get started creating signs, select the Open Sign File menu selection from the Open / Create 

Sign      menu.    A dialog box will appear, prompting you for a file name.    All Sign Maker files have the
.MST file extension.    Since this is probably your first sign, you will need to type in a new file name 
(You don't need to type in the extension, The Sign Maker does that for you!).    The Sign Maker will 
look in the specified directory for the file name you gave, if it can't find it (which will be the case for all 
new signs created) The Sign Maker will prompt you to create the file.    The next step is selecting a 
template. 



Selecting a Template
Now that you have created a new file, the next thing that The Sign Maker needs to know is which 

template to use.    A dialog box will appear and give you your choices.    We have provided all of the 
industry standard sizes, as well as full size letter and legal size for free style signs and posters.

Next, The Sign Maker needs to know how you would like your signs printed.    If you chose 3.5 X 
5.5    ( 4 per Sheet), The Sign Maker knows he has to print in LANDSCAPE    mode.    However, you 
are free to choose either PORTRAIT    or LANDSCAPE for any other sign template.      If you have any
trouble while deciding these issues, there is a help button in the printer setup dialog box that can 
explain most everything.    The next step is selecting a font . 



Changing the Font and Font Size
O.K., now we are ready to be creative.    Select Fonts... from the Font menu    and select the font 

and point size you want to start with.    Click the "OK" button when you have made your selection.    As
you begin typing, you may decide to change the font and/or the size.    You may change the style of 
characters already typed by highlighting    them, then performing the steps as mentioned above.    Use
your creative talents and be thoughtful in your sign layout,    explore the different fonts that come with 
Windows,    the "Wingdings" font is very interesting.    Keep in mind that more fonts are available 
through your retail computer dealer.    The next step, after completing your sign, is printing it .

Special note:

There is a program that comes with windows called "Character Map", usually found in the 
Accessories group.    Using this program is the easiest way to see all of the characters available for a 
certain font.    For example, look at the "Wingdings" font with the character map.    Help is available 
within the character map program, as with most Windows programs.

.



Landscape Printing
With Landscape printing, the paper is wider than it is tall when you view the printed sign upright. 

(The sign prints sideways on the paper).



Portrait Printing
With Portrait printing, the paper is taller than it is wide when you view the printed sign upright.



Printing a Sign
Printing a Sign Maker sign is as easy as pressing a button.    If you are like most users, you will 

use the mouse to move around the menus until you become more familiar with the hot-keys .    The F4
key is The Sign Maker's hot-key for printing, or you could select the print option from the File menu.    
Once you have printed your sign and made any necessary adjustments to the layout, you may want 
to save your sign    to a file for future use.



Saving a Sign
Saving a Sign Maker sign file is a good idea.    After spending time creating a sign layout that 

works best for you, you can save it and use it again and again.    To save a sign you have created to a
file, choose the    Save menu option from the File menu .

If you like, you can make your own "sign model" so to speak.      When you load this sign and 
modify it, you probably want to save it under a different name, so as not to destroy your "model".    To 
accomplish this, choose the Save As    menu option from the File menu.    You will be prompted for a 
new name.    

It is a good idea to use meaningful names when naming your sign files. Remember you are 
limited to 8 characters when naming a file (plus the 3 character .MST extension).    A good practice is 
to add a 'P' or 'L' to the end of the name to indicate Portrait    or Landscape    printing orientation, 
example: FEBSALEL.MST .    This naming convention is not required, however The Sign Maker will 
prompt you for the orientation every time the file is opened.    You do have the chance to change your 
selection using the Printer Setup    option from the File menu.    The Sign Maker does remember what
template    you selected when originally creating the sign.        



Open / Create Sign Menu
This is the only menu option available to you (with the exception of HELP) when you first start 

The Sign Maker.    

Open Sign File 

About Sign Maker 

Exit Sign Maker 



Exit Sign Maker
Use this menu selection to exit The Sign Maker program.    Make sure all work is saved before 

using this function.    (Save all of your files first!).



About Sign Maker
This selection displays a dialog box that tells a little bit about The Sign Maker, the version number

and copyright information.



Hot-keys
Use hot-keys as a short-cut method to accessing menu options.    If a menu option has a hot-key 

assigned to it,    the key or key combination will be displayed to the right of the option.    Also, for main 
menu items, press the    ALT key plus the underlined letter of the option to open the associated sub-
menu.



Sign Maker's Help Features
Here are some things you should know about The Sign Maker:

As with most Windows applications, on-line help is only a key press away.    The Sign Maker also 
incorporates what is known as "Context Sensitive Help ".    The standard function key for obtaining 
Help is the F1 key.    You may access help from within The Sign Maker (once you have opened a file 
and are in the edit mode) by highlighting a menu option using the cursor keys and pressing the F1 
key.    The use of the cursor keys is required because using the mouse causes that particular menu 
selection to be selected.    An easy way to get help on a particular selection without going through the 
help index is as follows:

I would like to know what superscript does, so I click on Fonts    from the menu bar ( Hot-key    users 
would hit the ALT+O keys). The choices available under Fonts are displayed.    I use the down arrow 
key to highlight the superscript selection.    Now, if I press enter with this selection highlighted, it is the 
same as clicking it with the mouse, but we want Help so we'll hit the F1 key instead.    The help screen
for superscript pops up.    

Keep in mind that the Help System is a separate program.    If you would like the Help window to 
stay on top of The Sign Maker, select the Help menu, then select "Always on Top".    Note: This 
procedure is done from within The Sign Maker Help screen.    



Context Sensitive Help
This type of Help system gives you help on the option or topic currently selected.



Registering The Sign Maker
To register your copy of The Sign Maker and receive the lastest,    full featured program, simply 

send your company check or money order for $50.00 in U.S. funds to:

Michael Dunn
re: Sign Maker
4342 S.W. Lagrange St.
Port St. Lucie, FL    34953
Sorry, no personal checks or C.O.D.'s.

Please include your complete mailing address and diskette size preference ( 5¼ or 3½).    Residents outside the 
U.S. include an additional $5.00 U.S. for overseas mailing.    You can print the order form    by selecting    Print 
Topic from the File menu.



What is The Sign Maker for?
The Sign Maker is used for.... you guessed it!!!    Making signs.    

I do not own a retail store, nor do I have a need for making signs all of the time.    I went to a trade
show a while back and saw a machine that makes signs, the type that you see at retail stores.    This 
particular machine does a great job, uses waterproof ink and has a lot of built in functions that you 
see in expensive type setting machines.    Well, the machine is not very intuitive to use, rather difficult 
in my opinion, and extremely expensive.    I don't know how the general public feels, but to me a 
machine that just makes signs is a little pricey at $2,500.00!    I realize that the signs produced by this 
machine are of    higher quality than a laser jet printer is capable of producing.    However, how many 
signs do you hold underwater for 12 hours a day?    If your sign gets wet and the ink runs, print 
another one!

In today's market of low priced P.C.'s, you can get a substantial system for    less than $2,500.00 
(including a laser printer if you don't go nuts with the monitor and hard drive), with more than enough 
left over to buy software applications.    The point is, the P.C. is much more versatile and can replace a
lot of "dedicated" machines.    Anyone who is considering buying a machine like the one described 
above probably has a major need to spend money (or displays their products underwater!).      Enough
said? Good, go back to the tutorial now. 



Registration Form
The Sign Maker for Windows ver. 1.0

Name _________________________________

Street____________________________________________________

City    _____________________________________________________

State________________________    ZIP _________________________

Diskette size preference    3½"_______      or    5 ¼" _________

Please send me _____ copies of The Sign Maker at $50.00 per copy (Residents outside the U.S. add
$5.00 for additional postage).    I understand that one copy constitutes one license and that each 
machine that uses The Sign Maker must have its own license.

Enclosed is my company check or money order in the amount of $_________

Please mail this form with company check or money order in U.S. funds to:

Michael Dunn

re: Sign Maker

4342 SW Lagrange St.

Port St. Lucie, FL    34953





Printer Setup
This option invokes a printer specific dialog box for the default printer (the default printer selection

is made from the control panel of Windows).    You select the parameters from a set of printer specific 
options.    These options include page size, page orientation, resolution, etc.    A help button is 
available within the dialog box if you need help on any of the controls.    For the majority of 
users, you will use the default settings, with exception to paper orientation. (You are prompted for this 
when creating or opening a sign file).



Print
Use this option to print your sign.    You may also choose to print only the selected part of the sign.

To print a block of text, the desired text must be highlighted before invoking the print function.

Also, you will be prompted whether or not to print the "guidelines" on the paper.    This is in case 
you are using a "pre-perforated" stock and do not require the guidelines for cutting purposes.

The print function will print on the default printer selected from the Windows' control panel.    The 
Sign Maker will select the closest printer fonts that match with the display fonts.    You can alter certain
print parameters using the printer setup    prior to invoking the print option.



Exit File
Use this function to exit from the sign editing session.    If the current sign file is modified, you will 

be prompted to save the modifications.

Please note that this does not exit The Sign Maker, but rather closes the current sign file.



Save File As
This selection is similar to Save File .    In addition, it allows you to specify a new file name for 

saving the text.    As with the Save function, this feature is disabled with the trial shareware version.



Save File
Use this selection to save the text and format data to the current file name.    If a file name is not 

yet specified, The Sign Maker will prompt you for a file name.    If a file with the same name already 
exists on the disk, The Sign Maker will save the previous file with a backup extension (.MS~).    This 
feature has been disabled for the trial shareware version.



Change Font and Point Size
Use this function to change the font typeface and point size of the current character or of all 

characters in a highlighted block of text.

If you wish to change the font for a highlighted block of text, highlight the block using Line    or 
Character    highlighting methods.    If you wish to change the font of a single character, position the 
cursor on that character, then select the font option from the font menu, or hit the ALT + F10 keys 
together.    A dialog box will appear that shows the list of Fonts and point sizes available.    

This option also allows you to change the default font. To change the default font, check the 
default font box.    This selection will apply the new font and point size to all the characters in the sign 
that used the previous default font.    



Highlight a Character Block
Use this function to highlight a block of characters.

Mouse:    Position the mouse cursor on the first character of the block and depress the left button.    
Holding the left button down, drag the mouse to the last character of the block and release the button.

Keyboard:    Position the cursor on the first character of the block and depress the shift key. Holding 
the shift key down, use the arrow keys to position the cursor on the last character of the block and 
release the shift key.



Highlight a Line Block
Use this function to highlight a block of lines.

Mouse:    Position the mouse cursor at any position on the first line of the block and depress the right 
button.    While the right button is depressed, drag the mouse down to the last line of the block and 
release the button.

Keyboard:    Position the cursor at any position on the first line of the block and hit the F8 function key. 
Use the Up and Down arrow keys to position the cursor on the last line and hit the F8 key again.

Normally, a function that uses a line block ( Cut/Copy ) will also erase the highlighting.    To 
explicitly erase the highlighting,    click the mouse one more time or hit the F8 key again.



Highlight the Current Word
Position the mouse cursor on the word to be highlighted and double click any mouse button ( left 

or right ).



Italic ON
Use this option to italicize the current character or to italicize all characters in a highlighted block 

of text.

To italicize the current character, hit the ALT+ 3 keys together ( or select the option from the 
menu).    to apply this format on a block of characters, highlight a block using the Line Block    or 
Character Block options.    Now, hit the ALT + 3 keys together (or select the option from the menu).

When you type in on the keyboard, the new characters automatically assume all the formatting 
characteristics of the preceding character.

To turn off the italic format, select the NORMAL    function.



Reset Character Formats ( Normalize )
Use this selection to reset all character formats (bold , underline , italic ,superscript , subscript 

and strike through ) for the current character or for all characters in a highlighted block of text.

To reset the character formats for the current character, hit the ALT + 0 (zero) keys together ( or 
select the option from the Font Menu).    To reset the formats for a block of characters, highlight a 
block using the Line Block    or Character Block    techniques.    Now hit the ALT + 0 keys together ( or 
select the option from the Font menu).



Underline ON
Use this option to underline the current character or to underline all characters in a highlighted 

block of text.

To underline the current character, hit the ALT + 2 keys together ( or select the option from the 
Font menu).    To apply this format on a block of characters, highlight a block using the Line Block    or 
Character Block    options.    Now hit the ALT + 2 keys together ( or select the option from the menu).

When you type in on the keyboard, the new characters automatically assume all the formatting 
characteristics of the preceding character.

To turn off underlining, select NORMAL    from the Font menu.



Bold ON
Use this option to apply the bold formatting to the current character or to all characters in a 

highlighted block of text.

To make the current character appear as bold, hit the ALT + 1 keys together ( or select the option 
from the menu).    To apply this format on a block of characters, highlight a block using the Line Block  
or Character Block    options.    Now hit the ALT + 1 keys together ( or select the option from the 
menu).

When you type on the keyboard, the new characters automatically assume all the formatting 
characteristics of the preceding character.

To turn off the bold formatting, select NORMAL    from the Font menu.



File Menu
This menu contains commands for saving and printing the current Sign Maker sign file.

Save 

SaveAs 

Page Layout 

Printer Setup 

Print 

Exit File 



Picture From Disk File
Use this command to read in a picture bitmap from a disk file at the current cursor location.    You 

may have to use the dialog box controls to change directory and locate your bitmap files.    All of the 
controls are easy to use and clearly marked as to their functionality.

You can invoke this function by hitting the ALT+F8 function keys together (or select the option 
from the menu).



Paste (text from clipboard)
Use this command to paste the text from the clipboard at the current cursor location.    If the 

formatting information is available, this command restores the formatting information properly. 

You can invoke this function by hitting the CTRL + V keys together (or select the option from the 
menu).



Copy (text to clipboard)
Use this command to copy a highlighted block of text to the clipboard.    The formatting 

information is also copied to the clipboard using a special clipboard format.



Cut (text to clipboard)
Use this command to cut a highlighted block of text to the clipboard.    This means that the 

previously highlighted area is copied to the clipboard, then deleted from the edit area.    The formatting
information is also copied to the clipboard using a special clipboard format.



Undo 
The Sign Maker remembers your last edit command.    Use this function to undo the last edit 

command.

You can invoke this function by hitting the Shift+F8 function keys together ( or select the option 
from the menu).    The editor will display a dialog box containing the information about the edit 
command to be undone.    The dialog box displays line number, column position, type of undo 
( delete/insert/edit) and the contents of the undo buffer.    You may modify the target line number or 
column position.    Confirm the operation by clicking on the OK button.    When reversing a delete 
operation, the editor will restore the deleted text in its original format.



Normal (Reset Paragraph Format)
Use this selection to reset all paragraph formats for the current paragraph or for all lines in a 

highlighted block of text.    This function is available depending on the template selected.      If the template
you have selected is not compatible, the menu selections will be grayed out, indicating that they are 
currently not available.

To reset the paragraph formats for the current paragraph, hit the Alt+P keys together (or select 
the option from the menu).    To reset the formats for a block of lines,    highlight a block using the Line 
Block    or Character Block    options.    Now,    hit the Alt+P Keys together (or select the option from the 
menu).



Centering
Use this selection to center all lines in the current paragraph or all lines in a highlighted block of 

text.    This function is available depending on the template selected.      If the template you have selected 
is not compatible, the menu selections will be grayed out, indicating that they are currently not available.

To center the current paragraph, hit the Alt+8 keys together (or select the option from the menu).   
To center a block of lines,    highlight a block using the Line Block    or Character Block    options.    Now,    
hit the Alt+8 Keys together (or select the option from the menu).



Right Justify
Use this selection to right justify all lines in the current paragraph or all lines in a highlighted block

of text.    This function is available depending on the template selected.      If the template you have 
selected is not compatible, the menu selections will be grayed out, indicating that they are currently not 
available.

To right justify the current paragraph, hit the Alt+9 keys together (or select the option from the 
menu).    To right justify a block of lines,    highlight a block using the Line Block    or Character Block    
options.    Now,    hit the Alt+9 Keys together (or select the option from the menu).



Sign Maker Command Menus
You will see these Menu headings once you have opened a sign file.    Refer to the Getting 

Started Section    of the help to open a new or existing file

File Menu 

Edit Menu 

Font Menu 

Justify Menu 



Edit Menu
      This menu contains clipboard functions, picture import functions, undo and copy/move functions.

Cut 

Copy 

Paste 

Picture From Disk File 

Undo 



Font Menu
This menu contains character formatting commands.

Normal 

Bold 

Underline 

Italics 

Superscript 

Subscript 

Strike 

Fonts



Justify Menu
This menu contains line formatting commands.    Only certain template    / orientation 

combinations support these options.

Normal 

Center 

Right Justify 

     



Superscript
Use this option to apply the superscript format to the current character or to apply it on all 

characters in a highlighted block of text.

To superscript the current character,    hit the Alt 4+ keys together (or select the option from the 
menu).    To apply this format on a block of characters,    highlight a block using the Line Block    or 
Character Block    options.    Now,    hit the Alt 4 Keys together (or select the option from the menu).

When you type in on the keyboard,    the new characters automatically assume all the formatting 
characteristics of the preceding character.

To turn off the superscript format,    select NORMAL



Subscript
Use this option to apply the subscript format to the current character or to apply it on all 

characters in a highlighted block of text.

To subscript the current character,    hit the Alt+ 5 keys together (or select the option from the 
menu).    To apply this format on a block of characters,    highlight a block using the Line Block    or 
Character Blockoptions.    Now,    hit the Alt+ 5 Keys together (or select the option from the menu).

When you type in on the keyboard,    the new characters automatically assume all the formatting 
characteristics of the preceding character.

To turn off the superscript format,    select NORMAL



Strike Through
Use this option to apply the strike format to the current character or to apply it on all characters in a 
highlighted block of text.

To strike the current character,    hit the Alt+6 keys together (or select the Line Block    or 
Character Block option from the menu).    To apply this format on a block of characters,    highlight a block 
using the    options.    Now,    hit the Alt+6 Keys together (or select the option from the menu).

When you type in on the keyboard,    the new characters automatically assume all the formatting 
characteristics of the preceding character.

To turn off the superscript format,    select NORMAL



Page Layout
Use this option before selecting the Print option to specify the page layout.    This will help in 

vertically centering your text if you have chosen a 7x11 or similar template, and are printing in landscape.  
I usually set the top margin to .5 inches.    Your sign may vary.

Margin (left, right, top and bottom) in inches.

You can invoke this function by hitting the Ctrl F4 function keys together (or select the option from
the menu).


